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Welcome.
Thank you for downloading Chronories! Chronories is a smart diary application from 
Synium Software with just that little extra. This guide will explain the elements of the user 
interface as well as basic usage.

Installation and De-Installation of Chronories
2. Download Chronories from our website
3. Double-click the installer file after the download has finished. This installation 

window will open: 

3. Please drag and drop Chronories (the diary icon) into your Applications folder 
in any case. This is required for Chronories to work properly. 
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Registration

Chronories can be purchased from our distribution partner whoʼs linked on our 
website. Simply click “Buy now” on our website and follow the instructions 
given there. After checking out from the store, youʼll receive an email 
containing your Serial Number.

This number will unlock all restrictions of the demo version so you end up with 
the regular application without another download. As long as no Serial Number is entered, 
Chronories will pop up a window every time you launch it, requesting a Serial Number. 
Please copy the entire number you received in that text field and confirm.

Update Chronories

Chronories comes equipped with an automatic update feature. A single click will start the 
download, installation and relaunch of Chronories. Make sure your Mac is connected to 
the internet and follow the instructions given by the updater. During installation you are 
asked for a password. This is your system password of OS X.

Please enter the entire Serial Number, including ”SYN-MEMO” and 
all the hyphens which looks similar to the following pattern:

SYN-MEMO-1234-ABCD-1234-1234-ABCD-1234-ABC
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Using Chronories
Chronories is designed to be as easy to learn as possible. The user interface is divided 
into five major sections:

Calendar browser
Diagrams

Searches
Bookmarks
Diary Page

User Guide Chronories

5



Diary Entry

One of Chronoriesʼ main features is, of course, the ability to write your diary. 
Chronories offers one page per day, identified by the day of the week and the date.  
This is the place to write your journal entry. In the top left corner, youʼll find a 
calendar, allowing you to freely navigate to a specific diary page. 

Click any date in the calendar to open the corresponding page. The “Today” button will 
return you to todayʼs date immediately.  Step by step, this is how to write a diary entry:

1. Select the date for which you intend to enter a diary entry
2. Click below „Diary Entry“ in the main window
3. Now you can write down what you want
4. Go to the Format menu and select whatever formatting option you like

Fonts, colors, sizes

The “Diary Entry” text field supports full formatting. How to change text parameters:
1. Select a piece of text
2. Click “Fonts” in the Format menu and select the appropriate formatting options 

like font type, letter size, color, bold, italic or underlined.

In order to change a text blockʼs alignment, select the entire block and choose the 
appropriate alignment from the Format menuʼs “Text” entry.

Your Mood

How do you feel today? Click the smiley button that best describes your mood. 
After a few weeks, youʼll have gathered representative data that can be visualized 
as diagrams. Youʻll find instructions how to create a diagram in the Diagrams 
section. You can either use Chronoriesʻ main window in order to enter your mood 

or rely on the menu bar service reminding you once a day.

Interesting Topics

Enter topics that caught your attention today. Topics can consist of several words 
separated by blanks. Press the “Enter” key to start your next entry. This is how it 
could look like after entering interesting topics:
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! Was it a newspaper headline? Something a friend told you? Something you saw on 
! TV, read in a book or found on the internet? Maybe youʼre planning a party or a 
! weekend trip? This is the perfect place to collect these topics. 

Places

In the Places section, enter where youʼve been today.  Just as already learned in 
the „Interesting Topics“ section, entries can consist of one or more words. Press 
the “Enter” key to start your next entry. This is how it could look like after entering 
places:

!

Contacts

Contacts are gathered automatically  from iChat, Adium or Mail.app. Everyone you 
chat with is listed here. Additionally, contacts from sent or received emails are 
shown. Delete contacts from the list by clicking them and pressing the Delete key 
on your keyboard.

Computer Activity

This graph automatically shows you when you used your Mac actively  and when it 
was sitting idle. Higher blue bars mean you where using your Mac intensely: Lower 
blue refers to medium activity. When moving away from your Mac, youʻll notice a 
white gap. Here you can see an example:

! !
Local Weather

The very first time you launch Chronories, youʼre asked to specify your location. 
Based on that information, Chronories automatically  downloads weather data for 
your area at least once a day. This data is retrieved from Accuweather.com. In 
case you booted your Mac early in the morning and would like to update that data 

at noon, click the Update button next to the Local Weather category. This is how it looks 
like after Chronories successfully gathered weather data:
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!
Please note that weather data can only be gathered while your Mac is running. If you donʼt 
use your Mac for a week, Chronories can not gather data for that week.

Applications Used

Chronories automatically tracks all applications you launch, for how long they 
were running and how long you were using them. The Menu Bar Service has to be 
active for this feature. This is what you can see after Chronories has been running 
for a while:

There is an application you do not want to be monitored? Ignore or hide this specific 
application by clicking on the little icon next to the term „“Applications Used“. The icon 
becomes active when you move your mouse to the headline.

Whatʻs the difference between „ignore“ and „hide“? If you hide an application,  Chronories 
still tracks its activity but doesnʻt show you how long that app has been running. 

If you ignore it, Chronories doesnʻt even count the time you have been working !with this 
application. This might be useful if you do not want to see the Mac OS X Finder (which is 
always active!) on your diary page.

Music

Chronories can track all the music you listened to in iTunes over the course of a 
day. Not only does Chonories show you which pieces of music you listened to in 
iTunes but also how much time you spent with that song. You have new favorite 
song and listened to it over and over again? Wow, 95 minutes you spent with one 

! song! Quite interesting information Chronories is gathering for you.

Please see for yourself:
1) Open iTunes
2) Start a song and listen to it
3) Stop that song or switch to another one
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4) Chronories will show you this on the main page:

RSS News Headlines

RSS is one of THE internet technologies when it comes to gathering information. 
RSS feeds are available from most news websites, giving you just the headlines to 
sort out the information youʼre interested in and read the full article then.

Please add Feeds youʼre interested in (from your favorite news site, for example) in the 
Chronories Preferences:

1) Open the preferences in the Chronories menu and select the Categories pane
2) Click on RSS
3) A new sheet appears, click on the plus button on the bottom
4) Enter the RSS feed

Desktop Screenshots

Capture your Macʼs screen to see your background images change over time, see 
the differences between Mac OS X versions or easily take a snapshot of a video 
chat. Click the Capture button, in case youʼve set up a second display, select 
which display to capture from the pulldown window.

You can either use Chronoriesʻ main window in order to take screenshots or rely  on 
! the menu bar service reminding you once a day.
Screenshots you have taken on one day, sorted by date:
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Other Images

Drag and drop images from the Finder or your Desktop  into the “Other Images” 
area or click the “Add Image…” button to browse to the imageʼs location. You can 
store whatever image youʻd like to save for that day.

iSight Photos

Take a portrait snapshot and see how your hair and your clothing changed over 
the course of a month. Click the “Take Image” button. A live view window will 
open. Click the “Take Image” button in that window. A countdown will start and the 
image is taken and automatically added to your journal page.
You can either use Chronoriesʻ main window in order to take a photo or rely  on the 

menu bar service reminding you once a day.

e-mails

All e-mails sent and received with Appleʼs Mail application can be tracked 
automatically and are then stored as backup  copies in Chronories. The Menu Bar 
Service has to be running for the e-Mails feature to work. If you delete an email in 
your mail application, this message still is stored within Chronories. When you 

open Chronoriesʻ category preferences and double click on „email“, you can define certain 
mail accounts. Attention! This does not include or exclude mail accounts from being logged  
(which is not possible). Defining mail accounts there just tells Chronories to automatically 
gather „contacts“ from emails, that are being sent or received through this account.

Chat Statistics

Find out who youʼre chatting with the longest. Chronories tracks start time and 
duration, as well as your chat partner. Chat Statistics supports iChat as well as 
Adium. The Menu Bar Service has to be running for this feature to work.

Visited Websites

Register which websites you visited today in Safari, Firefox or Chrome. Either 
sorted by domain name or like a browser history, Chronories will save this 
information for you automatically. Double-click an entry from the list in order to 
open that website in Safari. Visited Websites requires the Menu Bar Service to run.
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iCal Appointments

Chronories will scan your iCal calendars for you. That way, youʼll have all of your 
appointments in Chronories, right next to the rest of your information. Use 
Chronoriesʼ search feature for a full text search through your appointments and 
find all your hockey games or all meetings with Kathrin.

The Menu Bar Service
Chronories comes equipped with a service that is started at system boot time and will run 
in the background. Using this service gives you two major advantages:

1. Chronories doesnʼt have to run all the time in order to automatically log all your 
data

2. The service can be a constant reminder, helping you to keep writing your diary 
daily, entering your mood, taking photos of yourself or making screenshots. 

After clicking the icon in the Menu Bar, youʼll be able to enter your mood, take 
Screenshots and photos with your iSight without even launching Chronories. The 
Menu Bar Service logs all information activated in the Categories Preferences.

In case youʼre not comfortable with Chronories logging the websites you visit or anything 
else, simply  change the settings in the Preferences Menu. Remove, for instance, “Music” 
from the Categories list in the Chronories Preferences so Chronories will not track the 
music you listen to. 

Preferences
Open the Preferences from the “Chronories” menu. The second tab, called “Categories” 
lets you define which categories to include in your diary, the order in which they appear on 
the diary page and setup for example

• RSS feeds
• your location for automatic retrieval of weather data and 
• which mail accounts to monitor.

General
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The General settings let you configure the Menu Bar Serviceʼs behavior. You want to be 
reminded about todayʻs pending entries? The menu bar service can either show you a red 
badge or even let that badge flash in order to tell you: Please donʻt forget to enter 
information for that day!

Appearance

Select your preferred background color, the wood texture or whatever picture youʻd like to 
have. You can even ad your own images by clicking on the Select button.

Categories Preferences

Within the “Categories” preferences window:
1. Add or remove items from the list by clicking the plus and minus buttons below 

the list.
2. Change the diary page itemsʼ order by dragging them in place within the list.
3. Setup the items by double-clicking them in the list. This is possible when seeing 

the .-Icon next to the itemʻs name

Database Preferences

Here you can protect your database using a password, change that password, remove the 
password altogether or delete the entire database. Attention: After deleting the database 
youʻre data cannot be restored anymore!
After defining a password, nobody can access your data in Chronories without knowing 
what your password is.
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Auto Update
Activate or de-activate automatic checking for updates. In case youʼd like to install new 
versions as soon as they reach beta status, check the second option. The last option 
allows you to submit or suppress anonymous transfer of hardware version (for example 
iMac 20” late 2008 model), RAM and Graphics Card Memory and operating system 
version (i.e. Mac OS X 10.6.2) whenever an update is installed. This basically helps us get 
an idea of the average userʼs hardware operating speed and RAM configuration so we can 
optimise performance accordingly.

Diagrams
In the main windowʼs lower left part, thereʼs the Diagrams section. One diagram per item is 
preset, add a diagram by clicking the plus button below the left hand column, remove it 
with the minus button and double-click a diagram to change its settings.

In the Diagram Configuration window, youʼll be able to select which item to visualize, over 
which period of time and which sort of diagram to generate. This will allow you to see, for 
example, how often you had nice weather over the last month in a bar chart or see how 
your mood changed over the course of a year.

So how to create a diagram?
1. Click on the plus button on the bottom left
2. Select „new diagram“
3. Chose which categorie should be visualized
4. Define the Chart style
5. Select the time frame: „Ever“ visualizes from the first to the last entry Chronories has 

gathered. A certain time frame „from day x to day y“ uses the time in between.
6. Optionally chose a name for that diagram
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7. Now select your new diagram in the left side bar

Searching
Writing a diary is only helpful if you can easily retrieve the information whenever you need 
to. Chronories gives you a comprehensive full text search field, as well as saved searches 
which automatically collect search results in background.

Search field

Thereʼs a search field in the top right corner for ad-hoc searches. Enter “Susan” and the 
search results will show you every  mail to or from Susan, every Chat with her and every 
text entry that mentions her.

Choose any  search result from the list and the corresponding diary page will open. The 
word “Susan” will be highlighted, helping you find the right spot more easily.

Saved searches

In the left hand column, you can define search 
pattern presets for regular use. If you need to 
combine several search words and criteria, this is the 
right place to do so. 

Letʼs say you want to see all your RSS News 
Headlines about Apple. 
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1. Click the plus button in the main Windowʼs bottom left corner. 
2. Select “New Search”. 
3. A Configure Search dialog will open. 
4. Name the search “Apple”.
5. With your new Search selected, choose “Any” in the first drop-down menu.
6. Select “RSS-Feeds” from the drop-down.
7. Enter “apple” in the text field
8. Click the plus sign again and select the RSS-Feed
9. Now enter “mac” in the second text field as news might not specifically mention 

Apple but the mac.

This saved search will automatically  find all RSS-feeds mentioning Apple or the Mac. If any 
new Apple-related RSS headlines are gathered, these are added to your search results. 

This kind of Saved Search can be applied to all your data so you wonʼt miss any important 
information ever again. 

Bookmarks
Bookmarks are a way of quickly finding a specific diary page within your data:

1. Click on a date in the Calendar browser (top left)
2. Now click the plus button in the bottom left corner and select “New Bookmark”
3. By default, this bookmark is named after the date you just bookmarked
4. Double-click the bookmark in the left column
5. Rename it so youʼll easily recognize it when you need it
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Importing MacJournal entries
Chronories allows you to import entries from MacJournal. 

1. Open the File menu
2. Select Import -> MacJournal
3. A sheet opens that allows you to select the MacJournal database
4. Select the journal you want to import
5. Chose the import behavior, if there are entries in MacJournal and Chronories on the 

same day. You can append these entries, skip those days or replace Chronories entries 
by MacJournal entries. 

There is still something you urgently need to know? Just contact our email support: 
http://www.syniumsoftware.com/en/support/

Frequently asked questions

1) Chronories doesn't log anything on my computer!
Answer: Be sure to active the Menu Bar Service. This can be done by opening the 
preferences of Chronories or by accessing the Menu Bar Service in the Chronories 
menu.

2) I am using an application that can't be accessed by Chronories. What now?

Answer: While Chronories is able to monitor applications such as Mail.app, iTunes, 
Safari, Firefox and several more, we have to add support for new applications 
manually. Most companies chose to user their own way of storing data so there as 
to be an own importer for each app.

3) Will there be an iPhone/iPad version of Chronories?

Answer: Yes, definitely! We hope to release Chronories for iOS until early 2011.

4) I want to synch my Chronories database with another Mac. How can I do that?
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Anwer: Right now, you canʻt! We have planned to add a synchronisation feature 
but it isnʻt ready yet. 

5) I want to create a backup of my data. How?
You can export your Chronories database. Open the file menu, select „Export“ - 
Chronories Archive, then export all data you like. If you like, you can even import 
this file on a different Mac. 
If you like to import your data, just select „Import“- Chronories Archive, then chose 
the file you want to import.
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